
Screen
This little panel works only on specific models (such as the LC 500 series, 
Color Classic, and Mac TV), which tend to be Macs with built-in color 
monitors. These monitors have no knobs to adjust; therefore, you use this 
control panel to tweak the brightness, contrast, and automatic dimming. If 
you have any other model, toss this item.

Sound & Displays
For a brief, unhappy moment, Apple computer released this horribly 
confusing control panel as a replacement for what had been two control 
panels: Monitors and Sound. Only the first-release 7200, 7500, and 8500 
Power Mac models carried this control panel.

The interface has four panes that correspond to video (input and output) 
and sound (input and output). You have to double-click an item in one of the 
four directories to open a window containing the options you actually want 
to change. For example, if you double-click the Display field, you get what 
looks like the older Monitors control panel. To change your error beep, you 
click the System Sound button; another window opens, containing what 
used to be in the Sound control panel.

Serial Switch
For the Mac IIfx and Quadra 950 only; otherwise, out it goes. This tiny 
on/off switch affects the modem port speed — and, therefore, your success 
at getting MIDI software and modem programs to work. Switch the setting 
to Compatible if you use any kind of music software, or it’s bye-bye, MIDI.

Sharing Setup
Each Mac connected to a network must have its own identity. The Sharing 
Setup control panel allows you to assign your Mac a unique network name 
and to identify yourself as its owner (and, therefore, the one who 
determines which items on your Mac are shared and which aren’t).

Mostly, however, you use this control panel to turn File Sharing on and off. 
For details on File Sharing, networking, and this control panel, see Chapter 
32.

Sound



Why should you be content with a nondescript beep when you can make 
your Mac squeak, giggle, roar, burp, or play the theme song from “Hee 
Haw”?

With the Sound control panel , you can change your Mac’s alert sound, add 
sounds to and delete sounds from its repertoire, and adjust the overall 
volume of your Mac speaker. If you have the new Sound control panel 
(below), you also can record and play from your Mac’s CD-ROM drive, if you
have one.

 

f you have the new Sound control panel, it may take you a while to get used 
to its multiple-panel approach. The point is that each time you change the 
setting in the pop-up menu, the controls change in the panel portion. 
Chapter 14 covers some of the effects you can achieve by using different 
settings.

When the Sound panel’s pop-up menu is set to Alert Sounds (the only 
setting for the older control panel), you see the Mac’s small set of alert 
sounds: a quack, the Wild Eep, a droplet, and so on. To play a sound, click 
its name in the list or click the volume adjustment bar. Whichever sound is 
selected when you close the control panel becomes the standard alert 
sound. That’s an important fact to remember if you have long sounds in 
your arsenal, which are utterly annoying as error beeps (because the Mac is
incapacitated until the sound finishes playing).



Record a sound

To record sounds, your Mac needs some kind of microphone. Some models 
(Classic, LC, IIsi, and so on) require (and came with) the old-style gray Mac 
mike. Later models (Quadra 605, Power Mac, and so on) require the longer-
plugged PlainTalk mike ($20). And if your really old model doesn’t even 
have a sound-input jack on the back, you have to buy a mike that plugs into 
your modem port, like a MacRecorder (Macromedia).

To record, click the Add button, which opens a panel with tape recorder-like
controls . Click Record to begin recording your sound. Be ready to click 
Stop promptly when you finish, so that you don’t record a block of dead air 
at the end of your sound. To save what you recorded, click Save and assign 
the sound a name. It now appears in your list of available alert sounds.

Remove a sound

After you select the name of a sound you want to remove, you can get rid of 
it in three ways:

*
Click the Remove button. A dialog box appears, asking whether you’re sure 
that you want to remove the sound. If you click Yes, the sound is deleted 
from your System file. (You never can remove the Simple Beep.)

*
Choose Cut from the Edit menu, or type the keyboard equivalent: 
Command-X. If you use this method, you don’t get the warning dialog box. 
(After you cut the sound, you can paste it into your Scrapbook for long-term 
storage.)

*
The easiest way is to press the Clear key in the numeric keypad.

You can add as many sounds as you want to your system file, but watch out: 
digitized sounds take up lots of disk space. A seven-second sound file can be
150K or more. Adding too many sounds can bloat your System file quickly.

Sound control panel Secrets
How to rename a sound
You may think that there’s no way to rename a sound after you record it. Not so — here’s how.



In the Sound control panel, select the sound that you want to rename. Remove it from the list, using the 
Cut command (Edit menu). Next, use the Paste command (or press Command-V) to paste the sound 
back into your list. When you do so, you are asked to give the sound a name . Type a new name, and 
click OK.

Distributing or backing up your sounds
Any sound that you create with the Sound control panel becomes a draggable, trashable, movable icon, 
but it’s somewhat buried. To see it, open your System Folder; then double-click your System file. You’ll 
see all your sounds listed in the window. Manipulate them as you would any other icons.

Startup Sound Memos
If your Mac has a microphone, you can use the Sound control panel to leave audio messages for yourself 
or the next person who uses your Mac.

Record a message, using the Sound control panel. Double-click your System Folder; double-click your 
System file. Then drag the sound file that contains your message out of the System file and into the 
Startup Items folder (also in the System Folder). Your message automatically plays back the next time the
Mac is turned on.

Roll credits!
Do you have the new-style Sound control panel? Press Option as you make a selection from the pop-up 
menu. You’re treated to an utterance by a very drugged-out programmer — or somebody acting like one 
— and a quote from Jung.

                                                              
                                                            Why it’s called Sosumi

Ever wonder about the names of the sounds that come with System 7? For the most 
part, they’re onomatopoetic, spelled like they sound: “Wild Eep,” “Quack,” and so on. 
But what about that staccato E-flat diminished triad called “Sosumi”?

Early in Apple’s career as a computer-making superstar, there was a little legal trouble. 
(Apple’s always in legal trouble somewhere in the world.) And that trouble was with, 
believe it or not, the Beatles. The Beatles’ private record label was called Apple 
Records. The Beatles’ lawyers claimed that Apple, in making a computer with sound 
capabilities, was trying to get into the recording industry, causing confusion in 
consumers’ minds. After all, these two companies had the same names and were doing 
the same things, right?

So Apple sighed and promised Apple Records, in writing, that it would never get into the
recording industry. Apple Records backed off, and Macintosh went forth into the world.

A couple of years ago, however, Apple started including a microphone with most Mac 
models. And guess what you’re supposed to do with that mike? Yup — make 
recordings! It certainly would take a hypersensitive record company to interpret giving 
away a free microphone as “entering the recording industry.” But you never know. Some
wily Apple engineer, recognizing the potential litigation, gave the alert sound a name 
that serves as a subtle tribute to Apple Records: Sosumi!



Speech
This thoroughly enjoyable control panel lets your Mac read out loud. It’s the
command center for the Mac’s text-to-speech feature, in which the Mac 
speaks whatever you’ve typed into SimpleText (or other compatible 
programs). See Chapter 23 for the full Speech scoop.

Meanwhile, this control panel lets you choose a default voice and rate of 
speaking. Best of all, if you click the speaker icon, you hear each voice 
tested, saying something hilariously in character. For example, the “Good 
News” voice sings, to the tune of the Graduation March, “Congratulations! 
You’ve just won the sweepstakes, and you don’t have to pay income tax 
again.” Zarvox says, in its alien monotone, “That looks like a peaceful 
planet…” And Deranged says, voice shaking, “I-I need to go on a really long 
va -a-cation...”

Sometimes we think it must be really fun to work at Apple.

Speech Setup
You only need this control panel if you have an AV Mac or a Power Mac and 
you want to talk to it — or, rather, talk to it and have it respond. We’re 
referring, of course, to Apple’s PlainTalk speech recognition feature, 
discussed in detail (along with this control panel) in Chapter 23.

Oh, yeah — there’s a hidden credit in here. Turn on Balloon Help, and point 
to the version number. Wowww.

Startup Disk
Startup Disk tells your Mac which disk it should start up from. Throw it 
away unless you have more than one disk attached to your Mac. Weirdly 
enough, even disks that have no System Folders appear in the control panel.
Click the one that you want to be the startup disk the next time you turn on 
or restart the computer .

If you have more than one hard drive, or if you have a hard drive and a 
cartridge system (Zip or SyQuest, for example), it’s sometimes handy to 
have two system versions available — one System Folder on each drive. You 
use this control panel, in this case, to specify which System you want to be 
in control the next time the Mac starts. (Unfortunately, Startup Disk can’t 
distinguish among different partitions of a disk — only different disks.)



If you open this control panel and click in the blank white area around your 
disk icons, so that no icon is highlighted, the Mac will start up using the 
disk with the highest SCSI address number (see Chapter 30).

If you have only one hard drive, you can safely pull this one out of your 
System Folder.

Text
This special control panel, introduced in System 7.5, works in conjunction 
with WorldScript foreign-language systems. It allows you to specify (if 
you’ve purchased any foreign-language kits) which kind of writing system 
(Roman, Kanji, and so on) to use, and in which direction text should proceed
across the page. We guess that this is a good one to throw away.

Trackpad
This control panel    is, of course, useful only on PowerBooks — such as the 
500, 5000, or 2000 series — on which you control the cursor by touching a 
trackpad. The Trackpad panel’s controls are exactly the same as those in 
the Mouse control panel (see the “Mouse” section earlier in this chapter).

So why keep Trackpad and Mouse? Because you may want to use your 
PowerBook at home with a real mouse plugged into it, and yet use the 
trackpad when you’re on the plane. By giving you two separate control 
panels, Apple makes it easy to set up separate degrees of responsiveness for
each device. (This isn’t true of the 100-series PowerBooks, in which the 
Mouse control panel controls both trackball and mouse sensitivity.)

Users & Groups
You use the Users & Groups control panel to determine which network 
users (or groups of users) have access to the shared items on your Mac and 
the degree of access each user is granted. Look for full details in Chapter 
32.

Views
The Views control panel    can change the font for all text in Finder windows.
It also allows you to specify the information included in list views.

In the Icon Views portion of the control panel, you can specify how you want
icons to be displayed: along a straight or a staggered invisible grid. Select 
the “Always snap to grid” checkbox if you want icons to snap in line with an 



invisible grid when you drag them in Finder windows. (As mentioned in 
Chapter 1, you can always override the setting you make here — press the 
Command key as you drag the icon.)

 

ou choose the font from the pop-up menu near the top of the control panel. 
Smaller fonts work best, especially if you have many files and folders 
crammed into Finder windows. But you can choose any size up to 36 points .
Sizes larger than 24 points aren’t listed in the pop-up menu, but you can 
type larger point sizes directly in the size box, which is selected for editing 
as soon as you open the control panel. (Hint: select a font that’s built into 
the Mac, such as Geneva, Chicago, or Monaco; TrueType and ATM-ready 
fonts take the Mac longer to display.)

For list views, you also can specify the size of the icons that are displayed 
next to each file’s name. The largest of these views produces icons as big as
the full-size icons.

The checkboxes in the bottom portion of the control panel allow you to 
select the information you want to see in list views. List views look much 
better if you eliminate categories that you don’t use. If you don’t use Labels 
on your files, for example, deselect the “Show labels” checkbox. If the 



version number of each file is not important to you, get rid of that, too. If 
you deselect all the options, your list views shows only the names of files 
and folders .

There are two other list-view options to consider. Check “Calculate folder 
sizes” if you want list views to include the size (in kilobytes) of folders as 
well as files. (If this option isn’t selected, you simply see a dash for each 
folder’s size in a Finder window.) Do so only temporarily, however; when 
“Calculate folder sizes” is on, your Mac becomes sporadically sluggish as it 
attempts to add up the sizes of all your files in the background.

Check “Show disk info in header” if you want the amounts of available and 
used disk space to be displayed at the top of each Finder window. Both 
options provide useful information in your list-view windows.

Techie note: Views, by the way, is the only control panel you can control 
using AppleScript.

                                            The sedated hard disk window syndrome

Q: I’ve got a bizarre problem. When I double-click my hard disk icon — wow, it takes 
forever to open into a window...like two whole minutes. What’s going on?

A: You’ve fallen victim to a unique circumstance: you’re viewing your hard drive’s 
contents in size order (you chose, from the View menu in the Finder, “by Size”); and you
turned on “Calculate folder sizes” in the Views control panel.

You see, to display your hard disk contents in a list sorted by size, largest first, the Mac 
has to calculate the sizes of all the folders in it before it can open the window. That’s 
what causes the delay.

If you were to turn “Calculate folder sizes” off, you wouldn’t experience the delay, but all 
the folders would appear clumped at the bottom of your hard disk window, not sorted by 
size.

Likewise, if you choose any other sorting method from the View menu — by Name, for 
example — you wouldn’t experience such a slowdown.

WindowShade
WindowShade is yet another shareware-program-made-good: Apple 
appropriated it for inclusion with System 7.5. It’s a neat one, too, excellent 
for PowerBooks and other small-screen Macs. WindowShade allows you to 
collapse any open window into nothing but a title bar.



To take this anticlutter step, you double-click the title bar of the window. 
With a neat little whoosh, the main portion of the window disappears, 
leaving only the title bar floating on the screen. (Note, however, that both 
the whooshing and the collapsing features default to being off when you 
first install your system software. You must open the WindowShade control 
panel and switch them on first.)

Unfortunately, some programs have their own ideas of what a title-bar 
double-click means (in Excel and Word, it means “expand this window to fill 
the monitor”). Therefore, WindowShade allows you to change the number of
clicks required to collapse a window. You can even specify that you have to 
hold down a key (such as Option or Ctrl) while clicking for the collapsing to 
work.

In any case, you repeat the procedure to restore the window to its earlier 
size.

There’s only one Secret here — a very small one. To see the hidden credit, 
click the picture of the mouse button in the control-panel window.

 


